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Introduction 
This training program is designed to make your training experience comfortable 
and uncomplicated, providing thorough descriptions and step-by-step instructions.  
You should have a basic understanding of word processing before you begin this 
training program.  This program consists of two modules.  You are working in 
Module I, which is divided into two main parts:  Fundamentals and Beyond the 
Basics.   

Fundamentals provides instruction on the core tools and Beyond the Basics 
provides instruction on the additional tools you will need in order to produce legal 
documents in Microsoft Word 2003.  Follow this training module with Microsoft 
Word 2003 Legal Training, Module II, to learn the advanced document editing 
and handling tools you will need in order to create more complex legal 
documents.   

Each of the two main parts, Fundamentals and Beyond the Basics, are divided 
into sections containing step-by-step lessons which are followed by practice 
scenarios.  Where appropriate, multiple lessons are combined into one practice 
scenario. Each section is concluded with a list of notes and shortcuts.   

The step-by-step lessons are provided as a reference tool, and the practice 
scenarios are provided to allow you to perform the steps in a realistic fashion in 
the training environment.  Both sections of this training module are concluded 
with a comprehensive exercise.  The exercises should be performed individually 
upon completion of each section to reinforce the tools learned. 

To make this training manual relative to your daily work, the practice scenarios 
are based on a litigation case and the section exercises are based on a 
transactional matter.  The practice scenarios are “skits” based on two characters,  
an attorney and his legal assistant/legal secretary, and follow work flow in a law 
office.  The practice scenarios and exercises generally proceed in a realistic 
manner.  However, in order to provide the most effective practice scenarios and 
exercises, some of them may proceed differently than you might actually handle a 
similar matter in your office.   

Because many law firms are either migrating from WordPerfect to Word, or are 
using both word processing programs, this training program contains references 
to the differences and equivalencies of WordPerfect and Word.  This information 
is intended to give you a comprehensive understanding of how Word operates in 
comparison to WordPerfect, helping your transition be as stress-free as possible. 
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Installing the Practice Files 
Prior to working with this training program you must install the practice scenario 
files.   

Steps 

 Insert the CD into your CD Drive and following the on-screen prompts, or 

 Click on the Start button ( ) on the task bar, select Run from the 
menu and type x:\setup.exe in the Open: field where x represents your 
cd drive letter. 
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Module Conventions 
The following describes the conventions and instructions used throughout this 
training module. 

Mouse Clicks:  An instruction to “click” on an item refers to a single click of 
the primary mouse button.  (If your mouse is set for a right-handed user, the left 
button is the primary mouse button; if it is set for a left-handed user, the right 
button is primary.)   

An instruction to “click and drag” means to click on the specified object and 
while holding the primary mouse button down move the mouse pointer to the 
point specified, then release the mouse button.   

Shortcut Key Combinations:  Shortcut key combinations refer to a series of 
keystrokes used to execute a command.  Instructions referring to a shortcut key 
combination are displayed in 12pt Arial bold typeface and are separated by a 
hyphen in the order they should be pressed.  For a 2-key combination, press and 
hold the first key then press the second key; for a 3-key combination, press and 
hold the first key, then press and hold the second key, then press the third key.  
For example: Ctrl-P means to press the Ctrl key and while holding it down press 
the P key; Alt-Ctrl-C means to press the Alt key and while holding it down press 
the Ctrl key, and while holding them both down press the C key.   

Menu Bar:  An instruction to click on a menu is displayed in 12pt Arial bold 
typeface and is denoted as “click on [menu] on the menu bar.”  An instruction to 
select an option on a menu is denoted as “click on the following menu sequence: 
[menu] → [option].”  For example, the instruction to “click on the following 
menu sequence:  File  → Open” means to click on File on the menu bar to 
display the file menu, then click on the Open option.   

An underlined letter on the menu bar or on a menu option indicates that you can 
use a keyboard shortcut instead of your mouse to select the menu or option.  The 
instructions in this training module illustrate these keystroke references.  If the 
underlined letter is referring to a menu, press the Alt key, then the underlined 
letter for that menu.  For example, to open the File menu press Alt-F.  Once you 
have opened a menu, you can release the Alt key and press the underlined letter 
for the menu option you wish to select.  For example, with the File menu open 
press the letter O to execute the Open command.  Thus, the key combination to 
open a file using the shortcut is:  Alt-F, O.   

Command Buttons, Fields and Drop-down Lists:  An instruction to click 
on a command button, click in a field, or click on a drop-down list inside a dialog 
box is displayed in 12pt Arial bold typeface.    

An underlined letter on a command button, field name, or drop-down list name 
inside a dialog box indicates that you can use a keyboard shortcut instead of your 
mouse to either execute the command, place your insertion point in the field, or 
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display the drop-down list.  The instructions in this training module illustrate 
these keystroke references.  Press the Alt key, then press the underlined letter for 
the command button, field, or drop-down list you wish to select.  For example, in 
the Open dialog box, press Alt-O to execute the Open command, press Alt-N to 
place your insertion point in the File name field, or press Alt-I to display the 
Look in drop-down list.   

Notes:  A Notes area is provided for you on the outside margins of the steps and 
practice scenario sections throughout this module.  Important notes have been 
added for you where appropriate.   

Type:  An instruction to type something is displayed in 12pt Courier New 
bold reverse typeface. 

Practice and Exercise Files:  All references to practice and exercise files are 
displayed in 12pt Arial bold typeface.  The folders the files reside in or you are 
instructed to create are displayed in 12pt Arial italic typeface. 

Dialog Boxes:  All references to specific dialog boxes are referred to in 12pt 
Times New Roman italic typeface.    

Microsoft Word 2003:  All references to “Word” mean Microsoft Word 2003. 

Practice Scenarios:  The practice scenarios are scenes from a day in the life of 
attorney Joe Cool and his legal secretary/legal assistant, Sally Slick.  You will 
come to know them throughout the day.   

Mr. Joe Cool is an attorney at Cox and Brown.  He is approximately 45 years of 
age and is not very proficient with the computer, but he tries to be helpful.  He 
also is not a procrastinator.  He likes to get tasks completed before they are due. 

Ms. Sally Slick has been Joe Cool's legal secretary/legal assistant for 6 years and 
is converting from WordPerfect to Word.  She is very proficient in 
WordPerfect and looking forward to the challenge of changing to Word, but is 
apprehensive at the same time. 

At times these characters’ thoughts will be visible, preceded with an °°°. 

The Practice Scenarios are realistic in the demands that are placed on attorneys 
and legal assistants, but the timing may be a bit optimistic in that we receive a 
case in one day and by the end of that day we have answered the petition, drafted 
discovery and created a brief, and not necessarily in that order.  We have a very 
busy day…so let's get started. 



  Fundamentals 

© 2004 Software@Law, Inc.  5 

Fundamentals 
The Fundamentals portion of this training program consists of the core tools you 
will need to successfully manage your work in Word.  After completing this 
portion of the training module, you will be able to effectively manage and format 
Word documents with ease. 

The step-by-step instructions herein should be used as a reference.  Also included 
are detailed descriptions of the tools used in each section.  The practice scenarios 
and exercise will give you practical, hands-on experience.  A CD containing all of 
the practice scenarios and exercise files is provided with this training module so 
you can complete them as many times as you like. 
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Launching Microsoft Word 2003 
The following steps may vary slightly depending upon the version of Windows 
you are using.  The steps below illustrate opening Word using Windows XP 
where Word has been installed using the standard installation procedures.  If 
Word has been custom installed on your computer, these steps may vary. 

Steps 

1. Click on the Start button ( ) on the task bar. 

2. Point to All Programs with your mouse until the menu expands. 

3. Point to Microsoft Office 2003 with your mouse until the menu 
expands. 

4. Click on the Microsoft Word option ( ). 
 

Note:  You may have the Microsoft Word icon on your desktop which you 
can double-click on to launch the application.  The default Word 2003 icon 
appears as follows: 



Fundamentals 

8  © 2004 Software@Law, Inc. 

Navigating in Microsoft Word 2003 
In this section you will learn about Word’s on-screen navigation and shortcut 
tools that allow you to quickly maneuver through and manage your documents.   

This section includes the following lessons: 

• Touring the Screen 

• Navigating Using the Keyboard 

• Navigating Using Browse Objects 
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Notes 
Touring the Screen 

 

 
Screen Item Description 

Title Bar Displays the application and file name; contains 
the window resize and close buttons 

Menu Bar Contains available menus; contains the 
document close button 

Standard Toolbar Contains buttons for commonly used tools 

Formatting Toolbar Contains buttons for commonly used formatting 
tools 

Toolbar Handle Changes the location of the toolbar 

Task Pane Displays Word tools 

Horizontal Ruler 
Bar 

Displays margin settings, tab settings, table 
column widths and column widths 

Note: By default 
the formatting 
toolbar is on the 
same row as the 
standard toolbar.  
To see all the 
buttons on both 
toolbars 
simultaneously,  
hover your 
mouse pointer 
over the toolbar 
handle (the 
vertical gray bar 
to the left of the 
first button on 
the toolbar) on 
the formatting 
toolbar until it 
turns into a four-
sided arrow, 
then click and 
draft it below the 
standard toolbar. 

Browse  
Buttons 

Standard 
Toolbar 

Vertical 
Scroll Bar 

Horizontal 
Ruler Bar

Vertical 
Ruler Bar 

View Buttons 

Toolbar Handle Title Bar 
Menu Bar 

Horizontal  
Scroll Bar 

Status Bar 

Formatting 
Toolbar 

Task Pane 



Fundamentals 

10  © 2004 Software@Law, Inc. 

Notes 
Screen Item Description 

Vertical Ruler Bar Displays margin settings, table row heights and 
column heights 

View Buttons Changes document view 

Horizontal Scroll 
Bar 

Drag to scroll screen left or right 

Vertical Scroll Bar Drag to scroll screen up or down 

Browse Buttons Browse by word(s) or objects (such as pages or 
footnotes) 

Status Bar Displays location in document; displays status of 
grammar and spell check; contains buttons for 
commonly used commands 

 

If all document windows have been closed in Word, the document 
editing area will be gray.   
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Notes 
 
 
 

 

 
Click on the New Blank Document button ( ) to open a blank 
document screen or click on the Blank Document link on the 
task pane. 

 

 

New Blank Document Button 

Note:  You may 
close the task 
pane at any time 
by clicking on 
the Close button 
( ) on the task 
pane menu bar; 
to restore the 
task pane, click 
on the following 
menu sequence: 
View → Task 
Pane, or press 
the Ctrl-F1 
shortcut key 
combination. 

Blank Document Link 
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Notes 
Using the Task Pane 

The task pane is an area which contains links to various shortcuts 
and tools in Word.  It is similar to a menu.  For some tools, the task 
pane is optional; in other words, you may use the menus and other 
dialog boxes to achieve the same results you would by using the 
task pane.  However, some Word tools, such as styles and reveal 
formatting, may only be used through the task pane.  The 
following table describes Word’s task panes.  You will work with 
these task panes throughout this training program.  

 
Task Pane 

Getting Started (Optional) 

 

Word Help (Optional) 
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Notes 
Task Pane 

Search Results (Optional or 
Required depending upon tool 

used) 

 

Clip Art (Required) 

 

Research (Required) 

 

Clipboard (Required) 
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Notes 
Task Pane 

New Document (Optional) 

 

Shared Workspace (Required) 

 

Document Updates (Required) 

 

Protect Document (Required) 
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Notes 
Task Pane 

Styles and Formatting (Required) 

 

Reveal Formatting (Required) 

 

Mail Merge (Required) 

 

XML Structure (Required) 
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Notes 
Task Pane 

File Search (Optional) 

 

 

To turn the task pane on: 

 Click on the following menu sequence: View → Task 
Pane; 

 Press the Ctrl-F1 shortcut key combination; or 

 If you are using a tool set that can only be accessed through 
a task pane, the task pane will automatically open when 
you click on the menu sequence for the tool. 

To select a task pane: 

 Click on the drop-down arrow on the task pane menu bar to 
select another task pane; or 

 Click on the Back ( ) and Forward ( ) arrows on the 
task pane menu bar to scroll through the task panes; click 
on the Home ( ) button to go back to the Getting Started 
task pane.   
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Notes 

 

To turn the task pane off: 

 Click on the following menu sequence: View → Task 
Pane; 

 Press the Ctrl-F1 shortcut key combination; or 

 Click on the Close button ( ) on the task pane menu bar. 
 

Task Pane 
Menu Bar 

Task Pane 
Menu  
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Notes 
Navigating Using the Keyboard 

Keystrokes Insertion Point Movement 

← One character to the left 

→ One character to the right 

Ctrl-← One word to the left 

Ctrl-→ One word to the right 

↑ One line up 

↓ One line down 

Ctrl-↑ One paragraph up 

Ctrl-↓ One paragraph down 

Home To the beginning of a line 

End To the end of a line 

Page Up Top of the screen 

Page Down Bottom of the screen 

Ctrl-Page Up Top of previous or current page  

Ctrl-Page Down Top of next page 

Ctrl-Home Beginning of Document 

Ctrl-End End of Document 

Shift-F5 To previous revision or to the location of 
the insertion point when the document 
was last closed 

Alt-Shift-↑ Move current paragraph one paragraph 
up 

Alt-Shift-↓ Move current paragraph one paragraph 
down 

Alt-Shift-→ Increases heading style one level 

Alt-Shift-← Decreases heading style one level 
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Notes 

Navigating Using Browse Objects 
The browse navigation buttons are located at the bottom of the 
vertical scroll bar and appear as follows: 

 

 

The Previous ( ) and Next ( ) buttons move you forward or 
backward to whichever browse object is selected. 

The default browse object is page.  The browse object will change 
based on tasks you complete.  For example, the last item you 
searched for using Word’s Find feature will be the current browse 
object.  If the browse object is anything other than page, the 
Previous ( ) and Next ( ) buttons will appear in blue. 

Click on the Select Browse Object button ( ) to select from 
the browse objects as follows: 

 

The following table describes the browse objects: 

 
Browse 
Object Description 

 
Field - moves insertion point from field to field 

 
Endnote - moves insertion point from endnote to 
endnote 

 
Footnote - moves insertion point from footnote to 
footnote 

 
Comment - moves insertion point from comment to 
comment 

 
Section - moves insertion point from section to 
section 

 
Page - moves insertion point from page to page 

 
Go To - activates the Go To feature 

Note:  If the 
Previous ( ) 
and Next ( ) 
buttons are blue, 
hover over one of 
them to display a 
pop-up box 
indicating the 
current  
browse object. 

Previous Page or Object 

Next Page or Object 
Select Browse Object 
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Notes 
Browse 
Object Description 

 
Find - opens the Find dialog box to enter search 
criteria; next and previous buttons act as Find Next 
and Find Previous 

 
Edit - moves insertion point between edits to your 
document 

 
Heading - moves insertion point from heading to 
heading 

 
Graphic – moves insertion point from graphic to 
graphic 

 
Table - moves insertion point from table to table 

You will learn about these objects throughout this training 
program. 
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Document Management 
Document management encompasses the daily document handling you will do in 
Word, such as creating, saving, searching for, and printing documents.  

This section includes the following lessons: 

• Creating Documents 

• Saving Documents 

• Closing Documents 

• Opening Documents 

• Searching for Documents 

• Using Template Documents 

• Using Spelling and Grammar Check 

• Printing Documents 
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Creating Documents 
In this lesson you will create your first document.  Other than the information 
provided directly below, we will postpone instruction on applying and modifying 
formatting, such as font attributes, paragraph indents and paragraph numbering, 
for subsequent lessons. 

Before you get started it is important to understand that Word recognizes each 
line break (referred to as hard returns in WordPerfect) as a paragraph.  In other 
words, each time you press the Enter key, Word considers it a paragraph – even 
when you are using the Enter key to simply add space between paragraphs; the 
line break is considered a separate paragraph.  (As opposed to WordPerfect, 
which recognizes two line breaks as the distinguishing characteristic of a 
paragraph.) This becomes important when you are navigating through Word 
using keyboard shortcuts such as CTRL-↓, using find and replace tools and 
applying formatting.  Additionally, it is important to understand that Word stores 
all formatting information at the paragraph level.  Even blank paragraphs have 
formatting information stored in them, thus, increasing the file size of your 
document. 

To add space between paragraphs without adding an additional blank paragraph 
(line break), use the shortcut key combination Ctrl-0 (zero) rather than pressing 
the Enter key a second time.  The Ctrl-0 (zero) shortcut key combination is a 
toggle to increase or decrease space before a paragraph.  So you can use the Ctrl-
0 (zero) keyboard shortcut to either increase or decrease the space before a 
paragraph by one line. 

Further, there are times when you need to use line breaks within a single 
paragraph but do not want each line to be recognized as a separate paragraph  
(e.g., an address block).  Use a “manual line break” to force Word to recognize 
all lines of the text as one paragraph.  To insert a manual line break, press the 
Shift-Enter shortcut key combination. 

When you press the Enter key at the end of a line to create a new paragraph, the 
new paragraph will hold the same formatting as the previous paragraph.  Thus, if 
you type a paragraph and press the Enter key to create a new paragraph, and then 
press CTRL-0 (zero) to add or remove paragraph spacing, the subsequent new 
paragraphs you create by pressing the Enter key will automatically contain the 
increased or decreased paragraph spacing. 
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Lesson Objectives: 

• Create a new document using the toolbar, the menu bar and task 
pane and the shortcut key combination 

• Use the Ctrl-0 (zero) shortcut key combination to add or remove 
space between paragraphs 

• Automatically apply paragraph formatting (spacing) to new 
paragraphs
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Notes 

Steps 
If necessary (if the document editing area is gray), use one of the 
following methods to open a new blank document, and begin 
typing: 

 Click on the New Blank Document button ( ) on the 
standard toolbar (see Figure 1); 

 Click on the following menu sequence:   File → New, to 
open the following New Document task pane and click on 
the Blank Document template link; 

 

or 

 Press the Ctrl-N shortcut key combination. 
 
 
 

 
Figure 1 

New  Blank 
Document Button 

Blank 
Document 
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Using Spelling and Grammar Check 
 

Word’s Spelling and Grammar Check tool helps prevent spelling and 
grammatical errors while you are creating and editing documents.  This tool 
catches the errors and provides suggested corrections as you type.  Spelling errors 
are indicated by red squiggly underlining and grammatical errors are indicated by 
green squiggly underlining.  These error indicators will appear “as you type.” If 
preferred, you can choose to check the entire document at once rather than 
reviewing the error indicators as you type.   

Lesson Objectives: 

• Use the spelling and grammar check-as-you-type tool 

• Review a document’s spelling and grammar check status 

• Run the spelling and grammar check tool on an entire document at 
once using the toolbar, the menu bar, and the status bar 
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Notes 

Spell and Grammar Check As-You-Type 

Steps 

1. Right-click on any word that has a red squiggly underline.  
A context menu will appear. 

The following is an example of a Spell Check-As-You-
Type context menu: 

 

Word’s suggested corrections, if any, will appear in bold at 
the top of the context menu.  The following table describes 
the remaining Spell Check-As-You-Type context menu 
options: 

 
Menu Option Description 

Ignore All Skip the error, leaving the text as typed 

Add to Dictionary Add the word to Word’s spelling dictionary 

AutoCorrect Add the word to Word’s AutoCorrect feature 
(you will learn about AutoCorrect later in this 
training module) 

Language Change language 

Spelling  Open the Spelling and Grammar dialog box 

Look Up Opens the Research task pane where you can 
do research on the selected text 

Cut If text is selected, allows you to cut selected 
text to clipboard 

Copy If text is selected, allows you to copy selected 
text to clipboard 
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Notes 
Menu Option Description 

Paste Replace the misspelled word with the contents 
of the clipboard 

 

2. Click on the appropriate item in the context menu.  
 

Spell and Grammar Check an Entire Document 

Steps 

1. Use one of the following methods to begin the spelling and 
grammar check process: 

 Click on the Spelling and Grammar button ( ) 
on the standard toolbar (see Figure 7); 

 Click on the following menu sequence:  Tools → 
Spelling and Grammar;  

 Press the F7 shortcut key; or 

 Double-click on the Spelling and Grammar 
Status button ( ) on the status bar (see Figure 8). 

 

 
 

 
Figure 7 

 

 
Figure 8 

Spelling and Grammar 
Button 

Spelling and Grammar 
Status Button 
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Notes 
The following Spelling and Grammar dialog box will appear: 

 

Misspelled words will appear in red in the Not in Dictionary: 
field.  Grammatical errors will appear in green in the same field 
and the Not in Dictionary: field label will be replaced with the 
grammar rule violation (e.g., subject-verb agreement). 

The following table describes the command buttons in the Spelling 
and Grammar dialog box and the WordPerfect equivalent: 

 
Command 

Buttons 
WordPerfect  
Equivalent Description of Use 

 Skip Skip the error, leaving the text 
as typed 

 Skip All Skip the error, leaving the text 
as typed, for all occurrences in 
the document 

 Add Add the word to Word’s 
spelling dictionary 

 Replace Replace the error with the 
selected suggestion 

 Replace All Replace the error with the 
selected suggestion for all 
occurrences in the document 

 QuickCorrect Add the word to Word’s 
AutoCorrect feature (you will 
learn about AutoCorrect later 
in this training module) 

  Customize the Spelling and 
Grammar check tool  
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Notes 
Command 

Buttons 
WordPerfect  
Equivalent Description of Use 

  Reverse the most recent 
spelling and grammar check 
actions one at a time 

  Cancel the spelling and 
grammar check process 

2. Proceed through the document using the appropriate 
command buttons.  When the spelling and grammar check 
is complete the Office Assistant dialog pop-up will appear 
as follows: 

 

3. Click anywhere in the document editing area to remove the 
Office Assistant dialog pop-up. 

PRACTICE SCENARIO 

Joe Cool:  Here are some revisions to the Engagement Letter in 
the Jones case and please run the spell checker. 

Joe Cool:  °°°I wonder if she ever proofreads her work? 

Sally Slick:  Okay.  °°°I guess maybe he does read some of the 
documents before they are mailed out. 

1. Open the holEngag.doc file from the Holliday folder 
using your favorite file open method. 

2. Save it as jonEngag.doc in the Jones folder using save 
as.* 

3. Press the Ctrl-End shortcut key combination to position 
your insertion point at the end of the document; notice the 
misspellings in the last paragraph of the body. 

                                            
* See important note regarding metadata on page 27. 
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Notes 
4. Right-click on the word “asistant” and click on the 

correct spelling “assistant” from the context menu. 

5. Right-click on the word “woking”, select the 
AutoCorrect option and click on “working.”  

Note:  This adds “woking” to “working” to your 
AutoCorrect feature.  Anytime in the future that you type 
“woking”, it will automatically be changed to “working” 
when you press the Spacebar or the Enter key.  (You will 
learn about AutoCorrect in detail later in this training 
module.) 

6. Right-click on “cse” and click on the correct spelling 
“case” from the context menu. 

7. Save the changes and close the jonEngag.doc using your 
favorite file save and close methods. 

8. Open the cbAttNot.doc file from the C&B  folder using 
your favorite file open method. 

9. Click on the Spelling and Grammar button ( ) on the 
standard toolbar or press the F7 key. 

10. Word stops at the first misspelling it recognizes, which is 
“Defendent” in this document.  Make sure the word 
Defendant is selected in the Suggestions field and 
click on the Change All command button ( ). 

11. Continue through the document until all misspellings have 
been corrected. 

12. Press the Ctrl-End shortcut key combination to move your 
insertion point to the end of the document. 

13. Type the following:    He were moving very 
slowly.  He 

Note:  When you begin typing the second sentence, the 
green squiggly underline appears under the word “were.” 

14. Right-click on “were” and click on the correct verb form of 
“was.” 
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15. Save the document as jonAttNt.doc in the Jones folder 

using “save as”.* 

16. Close the jonAttNt.doc file using your favorite file close 
method. 

                                            
* See important note regarding metadata on page 27. 
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Collecting and Pasting Text 
Word has an extended clipboard feature called collecting and pasting.  You can 
hold up to 24 different items in the clipboard simultaneously and paste all of them 
at one time in a document in the order they were placed on the clipboard, or paste 
each item individually at different times.  The information you can paste in the 
clipboard may come from any Microsoft Office product, which makes it handy 
when you are working with the entire Microsoft Office suite. 

Lesson Objectives 

• Display the clipboard task pane 

• Collect information into the clipboard 

• Paste clipboard contents  

• Clear clipboard contents 
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Display the Clipboard toolbar 
 

 
 

 
Figure 15 

Steps 

1. Do one of the following to display the Clipboard task pane: 

 Click on the following menu sequence:  View → 
Task Pane, then click on the task pane menu arrow 
and select Clipboard (see Figure 15); or 

 Click on the following menu sequence:  Edit → 
Office clipboard. 

Task Pane Menu 
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Formatting Paragraph Tabs and Indents 
You can change tabs and indents in Word using the ruler bar, the Paragraph 
dialog box or the formatting toolbar.  Many Word formatting options, such as 
tabs and indents, are handled through the Paragraph dialog box, whereas 
WordPerfect’s formatting options are found in the Format menu.  Remember, 
when you change formatting in a paragraph, each subsequent new paragraph 
created by pressing the Enter key will hold the same formatting as the previous 
paragraph. 

Lesson Objectives 

• Apply tabs and indents using the horizontal ruler bar 

• Apply tabs and indents using the formatting toolbar 

• Apply tabs and indents using the paragraph dialog box 
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Setting Indents and Tabs from the Horizontal Ruler Bar  

Steps 
Figure 18 illustrates the horizontal ruler bar and the paragraph 
markers.   

 
 

 
   

Figure 18 
 

The following table describes the paragraph markers: 

 

Button Title 
Keyboard 
Shortcut Description 

 First Line 
Indent 

Tab Indent only the first line of 
a paragraph 

 Hanging 
Indent 

Ctrl-T to 
increase 

Ctrl-Shift-T to 
decrease 

Indent every line except the 
first line of a paragraph 

 Left Indent  Ctrl-M to 
increase 

Ctrl-Shift-M to 
decrease 

Indent all lines of a 
paragraph from the left 

 Right Indent   Indent all lines of a 
paragraph from the right 

Table 1 

Right Indent  

First Line Indent 
Hanging Indent 

Left Indent  Tab Button 
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The following table describes the tab buttons: 

 
Tab 

Button 
WordPerfect 
Tab Button Description 

  Left-align tab 

  Center tab 

  Right-align tab 

  Decimal tab 

  Insert a vertical line at 
the tab stop 

Table 2 

Setting Paragraph Indents 

1. Position your insertion point in the paragraph you wish to 
change or select multiple paragraphs using your favorite 
text selection method. 

2. Click and drag the desired indent marker as described in 
Table 1, above, to the desired location on the ruler bar (see 
Figure 18). 

3. Click anywhere in the document editing area to deselect 
any text. 

Setting Paragraph Tabs 

1. Click on the Tab button ( ) to the left of the horizontal 
ruler bar (see Figure 18) until the desired tab type, as 
described in Table 2, above, is displayed. 

2. Click on the horizontal ruler bar at the location you wish to 
place that tab type. 

3. Continue the above 2 steps until all desired tab stops have 
been set. 

 

Note: In Word 
many formatting 
options, such as 
tabs and 
indents, are 
handled through 
the Paragraph 
dialog box.   

Note: Use the 
Ctrl-Q shortcut 
key combination 
to remove all 
manually applied 
formatting from 
the current or 
selected 
paragraphs.   
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Indenting Paragraphs Using the Formatting Toolbar 

Steps 

1. Position your insertion point in the paragraph you wish to 
change or select multiple paragraphs using your favorite 
text selection method. 

2. Click on the Increase Indent ( ) or Decrease Indent 
( ) button on the formatting toolbar to increase or 
decrease to next or previous tab stop. 

 

 

 
 
 

Setting Indents and Tabs Using the Paragraph Dialog Box 

Steps 

1. Position your insertion point in the paragraph you wish to 
change or select multiple paragraphs using your favorite 
text selection method. 

2. Click on the following menu sequence:  Format → 
Paragraph. 

Decrease Indent 

Increase Indent 
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The following Paragraph dialog box will appear: 

 

3. If necessary, click on the Indents and Spacing tab to 
make it active. 

4. Triple-click in the Left or Right fields and type the desired 
indentation amount or click on the up or down arrow keys 
to adjust the indent amount. 

5. Select the indentation type (first line or hanging) by 
clicking on the drop-down arrow in the Special field. 

6. Select the amount of special indentation in the By field. 

7. Click on the Tabs… command button ( ) to 
manually set tabs.   

Note: As you 
make selections 
in the Paragraph 
dialog box, the 
paragraph 
formatting will 
appear in the 
Preview window 
as it will in your 
document. 

Note: If you wish 
to set tabs only 
(no indents), 
click on the 
following menu 
sequence to 
bypass the 
Paragraph 
dialog box and 
directly open the 
Tabs dialog box: 
Format → 
Tabs. 
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Understanding Styles 
A style is a stored set of formatting attributes applied to paragraphs or characters.  
Use Word’s predefined styles or your own custom styles for consistent formatting 
and efficient document editing.  To see an example of styles, just look at this 
training manual.  All of the section headings, numbered steps and exercises, and 
even this paragraph, are formatted with styles.   

It is highly recommended that you work with and understand styles rather than 
formatting documents on the fly.  While this is one of Word’s best features, it is 
one of the more challenging features to conceptualize if you are migrating from 
WordPerfect, as it is one of the fundamental differences between Word and 
WordPerfect.  While WordPerfect does have a styles tool that is useful, Word 
styles are the core element of every document.   

It is important to understand the fundamentals of styles.  Word bases everything 
on a style.  There are two types of styles:  paragraph and character.  Paragraph 
styles contain formatting which is applied to the entire paragraph, while character 
styles contain attributes which are applied to characters.  The default style name is 
“Normal.”  This is the style that is applied unless you specify otherwise; even if 
you change paragraph or character formatting as you type (direct formatting), you 
are still working with the Normal style.  You have been working with the Normal 
style up to this point in this training module. 

The WordPerfect concept for editing documents is to format documents “as you 
go.”  For example, in WordPerfect you can change the line spacing, and that is 
the set line spacing until you change it again; you can change the font, and that is 
the set font until you change it again.  Although you can format “as you go” in 
Word (direct formatting), you are better off using style-based formatting.  For 
example, in Word you can define a style with a specific line spacing size then 
easily apply the style to the appropriate paragraphs.  Using style-based formatting 
in Word makes document editing and sharing a much easier task.  

The great thing about styles is that you can consistently format and quickly edit 
your documents.  If you have documents that you always use certain types of 
formatting in, you can quickly apply styles instead of manually setting up the 
formatting each time.  For example, most courts require that filed documents 
contain double-spacing.  However, your pleadings often contain citation quotes, 
which require single spacing with a ½ inch indent on each side.  To accommodate 
this, you can set up a paragraph style that uses double-spacing and a paragraph 
style that uses single spacing with a ½ inch indent on each side.  To switch back 
and forth, you simply apply the appropriate paragraph style.   

Further, tables of contents can be generated based on styles – eliminating the need 
to manually mark headings to be included. 
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Searching for and Replacing Formatting 
Use Word’s Advanced Find and Replace tool to search for and replace 
formatting, such as paragraph line spacing or font attributes.  This feature is 
similar to WordPerfect’s Match Codes feature.   

Lesson Objective 

• Locate and replace formatting using Find and Replace 
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Steps 

1. Click on the following menu sequence:  Edit → Replace 
or press the Ctrl-H shortcut key combination. 

The following Find and Replace dialog box will appear: 

 

2. Click on the More command button ( ).   

The expanded Find and Replace dialog box will appear as 
follows: 

   

The following table describes the search options: 

 
Checkbox/Command 

Button 
Description 

Search  Select to search the entire document, up from 
the insertion point or down from the insertion 
point 

Match case Select to match case exactly as typed in the 

Note:  Word will 
remember the 
last search item 
and place it in 
the Browse 
Object.  Use the 
Previous ( ) 
and Next ( ) 
buttons located 
at the bottom of 
the vertical scroll 
bar to locate the 
next and 
previous 
occurrences of 
the last item 
searched. 

Note: Word will 
remember the 
last 7 search 
and replace 
items and will 
store them in the 
Find what and 
Replace with 
fields drop-down 
arrow; to repeat 
a previous 
search or 
replace, click on 
the Find what or 
Replace with 
field drop-down 
arrow and select 
the appropriate 
search or 
replace criteria 
to place it in the 
field. 
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Checkbox/Command 

Button 
Description 

Find what field 

Find whole words only Select to search for whole words only, not 
portions of a larger word (option is dimmed if 
you are using wildcards) 

Use wildcards Select to allow the use of wildcard operators. 

Sounds like  Select to locate words that sound like the word 
in the Find what field 

Find all word forms  Select to locate all forms of the word in the 
Find what field 

 

 

Select to locate formatting 

 Select to locate special characters 

3. Type the text you wish to search for in conjunction with 
formatting, if any, in the Find what field. 

4. Select the formatting codes you wish to search for using the 
Format command button ( ). 

Note: The * and 
? wildcards may 
be used when 
the Use 
Wildcards 
option is 
selected.  The * 
stands for any 
number of 
unknown 
characters; the ? 
stands for one 
unknown 
character. 
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  Figure 22 

 

5. Type the text you wish to replace with, if any, in the 
Replace with field. 

6. Select any formatting codes you wish to replace with in the 
Replace with field by clicking on the Format command 
button ( ) and selecting from the menu. 

 
Figure 23 

7. Click on the Find Next command button ( ).   
Depending on your selection in the Search drop-down list, 
Word will locate and select the first, next, or previous 
occurrence of your search criteria in your document and 
will present you with the following options: 

 

Formatting 
Codes 

Formatting 
Codes 

Note: As you 
select formatting 
codes you wish 
to search for or 
replace with, the 
codes will be 
displayed below 
the Find what or 
Replace with 
fields (see 
Figure 22 and 
23). 
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Command 

Button 
Description 

 Toggle between More and Less to show or hide 
advanced search options 

 Replace the selected text with the contents of the 
Replace with field 

 Replace all occurrences of the selected text with the 
contents of the Replace with field 

 Search for the next occurrence of the contents of the 
Find what field without replacing the selected text 

 Terminate the Replace procedure and exit the Find 
and Replace dialog box 

8. Click on the appropriate command button(s) as described 
above to continue throughout your document or discontinue 
Find and Replace. 

PRACTICE SCENARIO 

Joe Cool:  I just got an e-mail from Carrie Bean in the Holliday 
case.  I saved it in the Holliday folder, would you put a copy in 
the Jones folder and clean it up?  I'm not sure what her legal 
assistant has done to it. 

Sally Slick:  Sure, I'll clean them both. 

1. Open the holGar2.doc file from the Holliday folder. 

2. Save the file as jonGar2.doc in the Jones folder.* 

3. Press the Ctrl-H shortcut key combination. 

4. If necessary, click on the More command button 
( ) to expand the Find and Replace dialog box. 

5. Type Cox & Brown in the Find what field. 

6. Click on the Format command button ( ). 

                                            
* See important note regarding metadata on page 27. 
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7. Click on the Font option. 

8. Click on the Bold option in the Font Style list. 

9. Click on the OK command button ( ). 

10. If necessary, delete any text in the Replace with field and 
type the following:  Cox and Brown. 

11. Click on the Format command button ( ). 

12. Click on the Font option. 

13. Click on the Bold Italic option in the Font Style list. 

14. Click on the OK command button ( ). 

The following illustrates how the Find and Replace dialog 
box should appear: 

 

15. Click on the Find Next command button ( ). 

Note:  The Cox & Brown in the letterhead should be 
selected. 

16. Click on the Find Next command button ( ) 
again. 

Note:  The Cox & Brown in the letter closing should be 
selected. 

17. Click on the Replace command button ( ). 



Beyond the Basics 

 

266  © 2004 Software@Law, Inc. 

Notes 
The following information box will appear: 

 

18. Click on the OK command button ( ). 

Note:  Depending on your settings, the Office Assistant 
may appear and show the same information. 

19. Click on the Close command button ( ) or 
Cancel command button ( ). 

20. Save the changes to the jonGar2.doc file in the Jones 
folder. 

21. Keep the jonGar2.doc file open for use in the next 
practice scenario. 



  Index 

 

© 2004 Software@Law, Inc.  i 

Index 

A 
AutoCorrect ......................................................214–17 

Creating .............................................................215 
Deleting .......................................................216–17 
Using .................................................................216 

AutoFormat-As-You-Type................................219–23 
Options ........................................................220–22 

Automated features ...........................................213–28 
AutoText ...........................................................225–28 

AutoComplete....................................................227 
Creating .............................................................226 
Deleting .............................................................228 
Using ...........................................................227–28 

B 
Break...............................................................289–302 

Continuous section ......................................296–98 
Delete ...........................................................298 
Insert.......................................................297–98 

Line (text) ....................................................22, 294 
Next page section.......................................300–302 

Delete ...........................................................302 
Insert.........................................................301–2 

Page .............................................................291–94 
Section .......................................................296–302 
Text..............................................................291–94 

Browse object .........................................................117 
Buttons.......................................................9, 10, 19 

Bulleting ...........................................129, 160–61, 221 

C 
Closing documents........................................21, 31–32 
Codes 

Revealing........................ See Revealing formatting 
Collecting and pasting text............................67, 93–98 
Copying formatting...................................164, 163–65 
Copying text........................................................67, 85 
Correcting text ..............................................67, 75–77 
Creating documents ......................................21, 22–25 

D 
Date and time............................................197, 196–98 
Deleting text..................................................67, 75–77 
Document management.......................................21–62 
Documents 

Closing.....................................................21, 31–32 
Creating ...................................................21, 22–25 
Filenames.............................................................29 
Grammar check........................................21, 49–53 
Management ..................................................21–62 
New ...............................................................10, 24 
Opening ...................................................21, 33–45 
Printing ....................................................21, 56–59 

Saving ..................................................... 21, 25–29 
Searching ...................................................... 37–45 
Spell check.............................................. 21, 49–53 
Template ............................................................. 21 
View.................................................................... 67 

E 
Envelopes 

Printing.......................................................... 61–62 

F 
Filenames ................................................................. 29 
Find 

Formatting................................................... 258–62 
Special characters........................................ 265–69 
Text ..................................................................... 67 

Find and replace 
Advanced .................................................... 257–69 
Formatting................................................... 258–62 
Special characters........................................ 265–69 
Text ..................................................................... 67 

Find text ................................................................. 117 
Folder 

Create new .......................................................... 29 
Font .......................................................... 129, 145–48 
Footers.............................................................. 273–85 

Creating....................................................... 274–77 
Deleting....................................................... 284–85 
Modifying ................................................... 281–82 

Format painter .................................. 129, 164, 163–65 
Formatting 

Find and replace.......................................... 258–62 
Revealing ...................................................... 101–4 

Formatting text ................................................. 129–65 
Formatting toolbar...................................................... 9 

G 
Grammar check ............................................ 21, 49–53 

As you type ............................................. 49, 50–51 

H 
Headers............................................................. 273–85 

Creating....................................................... 274–77 
Deleting....................................................... 284–85 
Modifying ................................................... 281–82 

Headers and footers.......................................... 273–85 
Help.................................................................. 171–89 

For WordPerfect users ................................ 187–89 
Microsoft Word help................................... 172–82 
Office Assistant........................................... 172–82 

Options ........................................................ 176 
Horizontal ruler bar .................................................... 9 
Horizontal scroll bar............................................. 9, 10 



Index 

 

ii  © 2004 Software@Law, Inc. 

I 
Indents ....................................................................129 
Insert 

Continuous section break ..................................298 
Date and time ..............................................196–98 
Next page section break.....................................302 
Special characters ..........................................207–9 
Symbols.........................................................202–4 

Inserting date and time............................................197 

J 
Justification............................... 129, 142, 143, 141–43 

L 
Launching Word 2000 ................................................7 
Line (text) breaks..............................................22, 294 
Line spacing.............................................. 129, 136–38 

M 
Manual line break .....................................................22 
Margins....................................... 130, 131–32, 131–32 
Match codes....See Find, Formatting and Find, Special 

characters 
Menu bar.....................................................................9 
Metadata ...................................................................27 
Moving text ........................................................67, 85 

N 
Navigating ..................................................9, 10, 8–20 

Browse object ......................................................19 
Keyboard .............................................................18 
Task pane.......................................................12–17 
Touring the Screen ..........................................9–17 

New blank document ................................................10 
Next page section break..................................300–302 
Numbering .............................................. 129, 160, 221 

O 
Opening documents ......................................21, 33–45 
Opening Word 2000 ...................................................7 
Overtype ...................................................................76 

P 
Page break ..............................................................294 
Page size ........................................... 129, 130, 133–34 
Paragraph 

Bulleting .............................................. 129, 160–61 
Font ..................................................... 129, 145–48 
Justification ......................... 129, 142, 143, 141–43 
Line spacing ........................................ 129, 136–38 
Numbering.................................................129, 160 
Numbering and bulleting.............................159–61 
Spacing................................................................22 

Tabs and indents ............................................... 129 
Print preview...................................................... 56, 57 
Printing 

Documents ...............................................21, 56–59 
Envelopes.................................................56, 61–62 

R 
Redo ........................................................67, 80, 82–83 
Replace 

Formatting ...................................................258–62 
Special characters ........................................265–69 
Text..................................................................... 67 

Reveal Codes ....................... See Revealing formatting 
Revealing formatting.....................................67, 101–4 

S 
Save 

vs. Save as..................................................... 27, 28 
Saving documents .........................................21, 25–29 
Search..............................................................See Find 
Searching for documents.................................... 37–45 
Section break...................................................296–302 

Continuous...................................................296–98 
Selecting text.................................................67, 68–71 
Selection bar............................................................. 68 
Shortcut key 

Special characters ......................................... 208–9 
Styles .............................................240–41, 249–50 
Symbols ........................................................ 203–4 

Show/Hide...................................................101, 103–4 
Special characters........................................208, 207–9 

Find and replace...........................................265–69 
Shortcut key .................................................. 208–9 

Spell check....................................................21, 49–53 
As you type..............................................49, 50–51 

Standard toolbar ......................................................... 9 
Status bar.............................................................. 9, 10 
Styles 

Creating .......................................................238–41 
Predefined....................................................234–36 
Shortcut keys .................................240–41, 249–50 

Symbol 
Assign shortcut key....................................... 203–4 

Symbols 
Insert ............................................................. 202–4 

Symbols and special characters.......................... 201–9 

T 
Tabs and indents .................................................... 129 
Task pane ......................................................16, 12–17 
Template documents ................................................ 21 
Title bar...................................................................... 9 
Toolbar handle ........................................................... 9 

U 
Undo..............................................................67, 80, 81 



  Index 

 

© 2004 Software@Law, Inc.  iii 

V 
Vertical ruler bar...................................................9, 10 
Vertical scroll bar..................................................9, 10 
View..........................................................................67 

Buttons.............................................................9, 10 

Zoom..................................................... 67, 111–13 

Z 
Zoom .......................................................... 67, 111–13 


